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MODULE TWO   MICROSOFT EXCEL 2013 

Lesson  One:  Exploring Microsoft Excel 2013 

Lesson  1.1  Starting Excel 2013 

Using spreadsheets is a very well-known facility which allows you to make lists and perform 

calculations by exploiting the power and simplicity of tables. The spreadsheet program in the 

Microsoft Office package is called Excel. Each Excel file is called spreadsheet; each spreadsheet 

may be made up of numerous worksheets. Each worksheet is a table, i.e. a structure consisting of 

rows and columns, where the basic element is the cell. Each cell is therefore defined by two unique 

coordinates within the working area (row and column). A Microsoft Excel 2013 worksheet has a 

maximum size of 16,384 columns wide by 1,048,576 rows tall. 

Microsoft Excel is a spreadsheet developed by Microsoft for Windows, macOS, Android and iOS. 

It features calculation, graphing tools, pivot tables. It allows you to enter numerical values or data 

into the rows or columns of a spreadsheet, and use these numerical entries for calculations, graphs, 

and statistical analysis. 

Steps  

To starts Microsoft word 2013 

 Click Start. 

 Point to All Programs. 

 Click Microsoft Office 2013. 

 Click Microsoft Excel 2013. 

 Click Blank workbook and a new workbook opens 

 

Lesson  1.2 The User Interface 

The Microsoft Excel 2013 user interface uses ribbons and tabs. Many of the tools you use while 

working in Excel are located on the ribbon that displays across the top of the window. The ribbon 

is organized into task-oriented command tabs. Each tab is divided into task-specific command 

groups with commands and options that relate to the group name. 

https://en.wikipedia.org/wiki/Spreadsheet
https://en.wikipedia.org/wiki/Microsoft
https://en.wikipedia.org/wiki/Microsoft_Windows
https://en.wikipedia.org/wiki/Android_(operating_system)
https://en.wikipedia.org/wiki/Pivot_table
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Active Cell 

In an Excel 2013 worksheet, an active cell is the cell with the black outline. Data is always entered 

into the active cell. Column Letter Columns run vertically on a worksheet and each column is 

identified by a letter in the column header. 

Formula Bar  

Located above the worksheet, this area displays the contents of the active cell. It can also be used 

for entering or editing data and formulas. 

Name Box 

Located left to the formula bar, the Name Box displays the cell reference or the name of the active 

cell. 

Row Numbers 

Rows run horizontally in a worksheet and are identified by a number in the row header. Together 

a column letter and a row number create a cell reference. Each cell in the worksheet can be 

identified by this combination of letters and numbers such as A1, K56, or BC34.  
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Sheet Tabs 

By default there is one worksheet in an Excel file. The tab at the bottom of a worksheet tells you 

the name of the worksheet - such as Sheet1, Sheet2 etc. 

Quick Access Toolbar 

This customisable toolbar allows you to add frequently used commands. Click on the down arrow 

at the end of the toolbar to display the available options. 

Application Button 

Clicking on the Application Button displays a drop down menu containing a number of options, 

such as open, save, and print. The options in the Button menu are very similar to those found under 

the File menu in previous versions of Excel. 

Ribbon 

The Ribbon is the strip of buttons and icons located above the work area in Excel 2013. The Ribbon 

replaces the menus and toolbars found in earlier versions of Excel. 

 

Lesson  1.3  Creating a Workbook 

A Microsoft Office Excel workbook is a file that contains one or more worksheets that you can 

use to organize various kinds of related information. You can create a new workbook by simply 

opening a blank one. 

Steps 

To create a new workbook 

 Click the FILE tab. 

 Click New. 

 Click Blank workbook. 
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Lesson  1.4  Opening a Workbook 

 

You can open an existing workbook to work on in Excel instead of always starting with a blank 

workbook. The workbook may be on a storage device or in any location on the system. 

Steps: 

To open an existing workbook from a specific drive and folder location.  

 Open a blank workbook. 

 Click the FILE tab. 

 Click Open 

 Select the appropriate drive/folder that contains the work book.  

 Select the Excel file   

 Click the Open button 

 

Lesson  1.5  Saving a New Workbook 

Whether using the desktop or web version of Excel, you save documents through the FILE tab, no 

matter where you wish to save the document to. 

Steps 

To save a new workbook 

 Open a new blank worksheet 

 Click the FILE tab. 

 Select the Save button. 

 Select a location for you to save the workbook to. (Click Computer, then Browse.) 

 Type law Student Score in the File name box. 

 Select Documents from the list of folders. 

 Click the Save button. 
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Lesson  1.6  Closing a Workbook 

Steps 

To close a workbook  

 Click the FILE tab. 

 Click Close. 

If a message box opens, asking you if you want to save the workbook, click save. 

 

Lesson 1.7  Working with Worksheets 

The tab at the bottom of a worksheet displays the name of the worksheet - such as Sheet1, Sheet2 

etc. You can switch between worksheets by selecting the desired tab. You can add, rename, and 

move tab positions 

 

                                    The Excel Sheet Tab 

You can quickly insert a new worksheet by clicking on the button. Excel named these worksheets 

using a default name, so consider renaming your worksheets to reflect what they contain. To 

rename it, double-click on the existing sheet name (e.g. Sheet1) and type a new name. 

Step  

To copy and move a worksheet within a spreadsheet 

 Select the worksheet tab at the bottom of the worksheet window. 

 Select Move or Copy. 

 Select the location to copy the worksheet to. (Click (move to end)). 

 Select the Create a Copy checkbox. 
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Tip: You can also move a worksheet within a workbook by clicking a sheet tab, holding the left 

mouse button, dragging the sheet to the desired location. 

  

How to Rename a Worksheet 

Step  

 Select the worksheet tab at the bottom of the worksheet window. 

 Select the worksheet to rename 

 Right Click 

 Select Rename. 

 Enter the worksheet name into the highlighted worksheet tab. 

Tip: You can quickly move to the next sheet or previous sheet in the workbook by pressing 

Ctrl+PgDn or Ctrl+PgUp respectively. 

 

Lesson  1.8  USING THE RIBBON 

The Ribbon is designed to help you quickly find the commands that you need to complete a task. 

Commands are organized in logical groups, which are collected together under tabs. Each tab 

relates to a type of activity, such as writing or laying out a page. To reduce clutter, some tabs are 

shown only when needed. For example, the Picture Tools tab is shown only when a picture is 

selected. 

 

Excel Ribbon 

Steps 

Using the ribbon to make the text bold:  
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 Click the HOME tab. 

 Click B to make the text bold. 

 

Lesson  1.8.1  HIDING THE RIBBON   

You can’t delete or replace the Ribbon with the toolbars and menus from the earlier versions of 

Microsoft Office, although you can minimize it to allow for more onscreen space. When this option 

is in use, the ribbon reappears when you click on a tab, then disappears after you select a command 

or when you click anywhere in the worksheet. 

 Step 

To hide the ribbon 

 Double-click on the currently selected tab (ribbon hidden temporary) 

 Click on any tab. (The ribbon is displayed at the top of a few rows as an overlay.) 

 Click any cell in the worksheet. (The ribbon is minimized.) 

 Double-click on any tab. (The ribbon is permanently displayed once again.) 

 

Lesson  1.9  CLOSING / EXISTING EXCEL 

When you’re ready to quit Excel, you have several choices for shutting down the program: 

 Press Alt+F4. 

 If you have only one workbook open, click the Close button (the X) in the upper-

right    corner of the Excel 2013 program window. If you have more than one 

workbook open, you need to close each workbook individually using this method. 

 Double click the Excel Application icon in the top left corner of the Excel 

2013 program window. 

Be sure to save your changes before exiting the workbook you’ve been working on. If you attempt 

to leave the workbook without saving, an alert box appears in Excel warning you that your changes 

will not be saved. To save these changes before exiting click the Save button. If you don’t want to 

save your changes click Don’t Save. 
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Lesson Two   BASIC WORKBOOK SKILLS 

Lesson  2.1 USING THE KEYBOARD TO SELECT CELLS  

You can use the keyboard to select cells or a range of cells in the worksheet. This is done by 

clicking into the appropriate cell and using the arrow keys on the keyboard to move left, right, up, 

and down in the worksheet.  

To select a rectangle area around the active cell, hold down the SHIFT key and press the arrow 

keys.  You can move box by box or sheet by sheet. Now click in any box containing data in the 

sheet. You would have to hold down the Ctrl key while pressing an arrow key, which moves the 

insertion point as described here  

KEY COMBINATIONS  Where the Insertion Point move  

 

Press the DOWN arrow key  

 

 

To move one cell down. 

Press the RIGHT arrow key 

 

To move one cell to the right. 

 

 

Press the UP arrow key 

 

 

To move one cell up. 

 

 

Press the LEFT arrow key 

 

 

To move one cell to the left. 

 

 

Ctrl +  

 

To the last box containing data of the current row. 

 

Ctrl + 

 

To the first box containing data of the current row. 

 

 

Ctrl +  

 

To the first box containing data of the current column. 
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Ctrl +  

 

To the last box containing data of the current column. 

 

Ctrl + PageUp 

 

To the sheet in the left of the current sheet. 

 

Ctrl + PageDown 

 

To the sheet in the right of the current sheet. 

 

Ctrl + Home 

 

To the beginning of the sheet. 

 

Ctrl + End 

 

To the end of the sheet. 

 

 

Lesson  2.1  USING THE MOUSE TO SCROLL 

Steps 

To navigate through the worksheet using the mouse 

 Click cell A1 

 Click the Scroll Arrow at the bottom of the vertical scrollbar 3 times 

 Click the Scroll Arrow at the top of the vertical scrollbar 3 times 

 Click the Scroll Arrow at the right end of the horizontal scrollbar 3 times 

 Click the Scroll Arrow at the left end of the horizontal scrollbar 3 times 

 Hold down the [Shift] key and then drag the horizontal scroll bar to the right. 

 

Lesson  2.2  USING GOTO 

You can use the Go To command to find and select cells or select cells that contain specific data 

or types of data such as formulas, blank cells or cells that contain data validation. 

Steps 

Using Go To to navigate to a specific cell in the worksheet 

 Select cell A1. 
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 Select the HOME tab. 

 Select Find & Select in the Editing group. 

 Select Go To… 

 Type the cell reference G50 in the Reference box. 

 Click OK. 

 

Lesson  2.3  ENTERING TEXT 

You can enter text into cells by selecting the cell and then typing the text directly in the cell or in 

the formula bar. Unless formatted differently, the text is aligned to the left. If the length of the 

entered text is too long to fit in the cell, it will spill over to the adjacent cell if it is empty. 

 

Lesson  2.4  EDITING TEXT  

When you need to edit the data in a cell, you can edit directly in the cell or edit the data in the 

formula bar. 

Steps 

To edit cell entries in a worksheet. 

 Select cell C6. 

 Type 1978 in the cell 

 Select cell B6.   

 Type Christian in the selected cell. 

 Press Enter on your keyboard. 

 Double-click on cell C6. 

 Position the insertion point to the right of the number 7. 

 Press Backspace twice.  

 Type 18 at the insertion point. 

 Press Enter. 
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Lesson  2.5  SPELL CHECK  

The spelling tool allows you to automatically find and then correct spelling mistakes in your 

workbook. 

Steps 

To check the worksheet for spelling errors: 

 Click the REVIEW tab. 

 Click the Spelling button in the Proofing group. 

 Click Yes to allow continue checking at the beginning of the sheet. 

 Click Change. 

 Click Ok 

 

Lesson  2.6 SAVING THE WORKBOOK WITH ANOTHER NAME 

After making changes to the file, you might want to keep the original file intact and save the file 

with the latest modification as another file. You can use Save As to save a copy of a workbook 

with another name, another folder or another file type. 

Steps 

To rename an existing workbook 

 Click the FILE tab. 

 Click the Save As button. 

 Click the Browse Folder (to select where you want to save the workbook) 

 Type New Workbook at the file name  

 Click the Save button to save the file 
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Lesson THREE  CELL SELECTION 

You can quickly select cells, ranges, rows, or columns, or all data on a worksheet, for example, to 

format the data in the selection, or to insert other cells, rows, or columns.  

 

Lesson  3.1  SELECTING A RANGE OF ADJACENT CELLS 

Steps 

To select a range of adjacent cells 

 Click on cell B5 and then drag to cell F15. Release the mouse button. 

 Click any cell in the worksheet to deselect the range. 

 

Lesson  3.2       SELECTING A RANGE OF NON-ADJACENT CELLS 

Steps 

To select a range of non-adjacent cells 

 Click on cell B5 and then drag to cell B12. Release the mouse button 

 Press and Hold down the Ctrl key on the keyboard. 

 Click on cell D5 and then drag to cell D12.  

 Click on cell F5 and then drag to cell F12. Release the mouse button and Ctrl key. 

 Click any cell in the worksheet to deselect the range. 

 

Lesson  3.3  SELECTING THE ENTIRE WORKSHEET 

 Step 

To select all cells in a worksheet,  

 Click the Select All Button shown below 
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Click any cell in the worksheet to deselect the range. 

 

Lesson  3.4  SELECTING A ROW 

Steps 

To select a row: 

 Click row heading 3. 

 

Click any cell in the worksheet to deselect the range. 

 

Lesson  3.5    SELECTING A RANGE OF ADJACENT ROWS 

Steps 

To select a range of contiguous rows. 

 Click on row heading 3 and drag to row heading 8. Release the mouse button. 

 

Click any cell in the worksheet to deselect the range. 

 

Lesson  3.6  SELECTING A RANGE OF NON-ADJACENT ROWS 

Steps 

To select a range of non-contiguous rows. 
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 Click row heading 3.  

 Press and Hold down the Ctrl key on the keyboard. 

 Click row heading 5.  

 Click row heading 7. Release the mouse button and Ctrl key. 

 

Click any cell in the worksheet to deselect the range. 

 

Lesson  3.7  SELECTING AN ENTIRE COLUMN 

Steps 

To select an entire column: 

 Click on column heading A. 

 

Click any cell in the worksheet to deselect the range 

 

Lesson  3.8  SELECTING A RANGE OF COLUMNS 

Steps 

To select a range of columns: 

 Click on column heading A and drag to column heading C. Release the mouse 

button. 

 

Click any cell in the worksheet to deselect the range. 

 

 

Lesson 3.9 SELECTING A RANGE OF NON-ADJACENT COLUMNS 

Steps 

To select a range of non-adjacent columns: 

 Click on column heading A. 

 Press and Hold down the Ctrl key on the keyboard. 

 Click column heading C. Release the mouse button and Ctrl key 

Click any cell in the worksheet to deselect the range. 
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Lesson Four  WORKING WITH COLUMNS AND ROWS 

Lesson  4.1  ADJUSTING COLUMN WIDTH 

The default column width in a worksheet is 8.43 characters, but you can specify a width of 

anywhere between 0 (zero) and 255. Zero (0) column width hides the column, while 255 represents 

the number of characters that can be displayed in a cell that is formatted using the standard font. 

Steps 

To adjust the width of columns 

 Select the column to be adjusted and drag. 

 

Tip: You can double click on the line to the right of the column heading. 

 

Lesson  4.2  INSERTING COLUMNS AND ROWS 

When you insert blank cells in a worksheet, they go above or to the left of the active or selected 

cell. Excel will shift other cells in the same column down, or cells in the same row to the right, to 

facilitate the newly inserted cells. As well as this, you can insert entire rows above a selected row 

and entire columns to the left of a selected row. 

Steps 

To insert columns and rows in a worksheet. 

 Select column C. 

 Select the HOME tab. 

 Click the Insert button in the Cells group. 

 Select Insert Sheet Columns from the list. 

 Type Date in cell C1, then press Enter. 

 Select row 2. 

 Select the HOME tab 

 Click the Insert button in the Cells group. 

 Select Insert Sheet Rows from the list. 
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 Type the formula =today() in cell C2, then press Enter. 

 

Tip: You can also insert columns and rows by right-clicking on a column or row heading and 

selecting Insert from the menu. 

 

Lesson  4.3  DELETING COLUMNS AND ROWS 

You can delete a selected row and column. Before you delete, it is important to realize that any 

data located in the rows or columns being deleted will be deleted as well. If you make a mistake 

use the Undo button from the Quick Access Toolbar. 

Steps 

To delete columns and rows from a worksheet 

 Select column D. 

 Select the HOME tab. 

 Select the Delete button in the Cells group. 

 Select Delete Sheet Columns from the list. 

 Select row 4 

 Select the HOME tab. 

 Select the Delete button in the Cells group. 

 Select Delete Sheet Rows from the list displayed. 

 

Lesson  4.4  FREEZING AND UNFREEZING COLUMNS AND ROWS 

In Excel you can lock specific rows and columns by freezing or splitting panes. This allows you 

to scroll to other areas of the worksheet while a particular section remains visible as you do so. 

This can be used, for example, when comparing data over a long-period of time while keeping 

titles or a row of key figures fixed for you to use as a reference point. 

 

Steps 

To freeze and unfreeze columns and rows in a worksheet 
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 Select column A. 

 Select the VIEW tab. 

 Click the Freeze Panes button in the Window group. 

 Click Freeze First Column from the list. 

 Select column A to unfreeze or select any cell in the worksheet 

 Select the VIEW tab. 

 Click the Freeze Panes button in the Window group. 

 Click Unfreeze Panes from the list. 

 Select row 1 or any other cell in the worksheet. 

 Select the VIEW tab. 

 Click the Freeze Panes button in the Window group. 

 Click Freeze Top Row from the list. 

 Select Unfreeze Panes from the Freeze Panes list in the Window group. 

 Click cell B3 

 Select Freeze Panes from the Freeze Panes list in the Window group. 

 Click any cell and select Unfreeze Panes from the Freeze Panes list in the Window 

group. 
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Lesson Five   NUMBER FORMATTING 

 

Lesson  5.1  NUMBER FORMATS 

You can format cells to change the way numbers and text appear in the worksheet. Formatting 

does not change the underlying value of a cell. That underlying value appears on the Formula Bar 

when the cell is selected and is what is used in calculations. Formatting improves the overall 

appearance of a worksheet and makes numbers easier to read. Using formatting, you can add 

features such as currency symbols (€), percent symbols (%), and commas (,), as well as specify a 

fixed number of decimal places. 

Number formatting can be applied to a single cell, entire columns or rows, a select range of cells, 

or the whole worksheet. The default format for cells containing a value is the General Format. This 

style has no specific format and displays values as plain numbers – no dollar symbols, commas 

etc. 

 

Number Formats in Excel 

 

Lesson  5.2  ACCOUNTING NUMBER STYLE 

The Accounting format is also used for formatting monetary values, but with this format 

the currency symbols and decimal points of numbers in a column are aligned. In addition, 

the Accounting format displays zero’s as dashes and negative numbers in parentheses. 

Steps 
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 To format cells using the Accounting Number Format button: 

 Select cells A8 to E8 

 Select the HOME tab. 

 Click the Accounting Number Format button in the Number group. 

Tip: To select a different currency, click the arrow on the right of the Accounting Number 

Format button, and then select the currency you want from the list. 

 

Lesson  5.3   PERCENT STYLE 

Applying the Percentage format to existing numbers in a workbook results in those numbers being 

multiplied by 100 to convert them to percentages. For example, if a cell contains the number 5, 

Excel multiplies that number by 100, which means that you will see 500.00% after you apply the 

Percentage format. This may not be what you expected. To accurately display percentages, before 

you format the numbers as a percentage, make sure that they have been calculated as percentages, 

and that they are displayed in decimal format. Percentages are calculated by using the equation 

amount / total = percentage.  

For example, if a cell contains the formula =5/100, the result of that calculation is 0.05. If you then 

format 0.05 as a percentage, the number will be correctly displayed as 5% 

Steps 

To use the Percent Style button to format cells: 

 Select cells F5 through F9. 

 Select the HOME tab. 

 Click the Percent Style button in the Number group. 
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Lesson  5.4  COMMA STYLE 

The Comma Style format, or the thousands separator inserts commas in larger numbers to separate 

thousands, hundred thousands, etc. The Comma Style format also displays two decimal places and 

puts negative values in parentheses. It doesn’t display dollar signs. 

Steps 

To use the Comma Style to format cells: 

 Select cells A10 through F15. 

 Select the HOME tab. 

 Click the Comma Style button in the Number group. 

 

Lesson  5.5   DECIMAL PLACES 

For numbers that are already entered on a worksheet, you can increase or decrease the number of 

places that are displayed after the decimal point by using the Increase Decimal and Decrease 

Decimal buttons.  

By default, Excel displays 2 decimal places when you apply a built-in number format, such as a 

currency format or a percentage, to the cells or data. However, you can change the number of 

decimal places that you want to use when you apply a number format. To have Excel enter the 

decimal points for you, you can specify a fixed decimal point for numbers. 

Steps 

To change the decimal places in cells: 

 Select cells A10 through F15. 

 Select the HOME tab. 

 Click the Decrease Decimal button twice. 
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Lesson Six    TEXT FORMATTING 

 

Lesson  6.1  FORMATTING TEXT 

You can format cells to change the way text appear in the worksheet. Formatting does not change 

the underlying value of a cell but can improve the overall appearance of a worksheet. You can 

apply formats to a cell before or after you enter the data. Formatting can be applied to one cell; a 

range of cells, columns, or rows; or the entire worksheet. Text alignment controls how the text 

lines up within cells. You can use the controls on the HOME tab to work with cell alignment. Cell 

alignment refers to how the text interacts with the available space in the cell. 

 

Lesson  6.2  CHANGING THE FONT AND FONT SIZE 

Calibri (Body) in font size 11 is the default font Microsoft Excel uses. However, this can be 

changed to another font and font size which is then applied to all new workbooks that you create. 

 

Lesson  6.3  BOLD AND ITALIC 

You can display the text as bold and italic for selected cells or ranges in a worksheet. 

  Steps 

To bold and italicize existing text: 

 Select the cell range you want to Bold 

 Select the Home Tab 

 Click on Bold Button in the Font group 

 

Tip: You can use keyboard shortcuts to apply bold (Ctrl + B) or italic (Ctrl + I) formatting to text 

in selected cells. 

 

Lesson  6.4  FONT COLOUR 

You can change the font colour of the selected cells or range of cells in a worksheet. 

 

  Steps 

 Select the cell range to change the Font color 
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 Select the HOME tab. 

 Click the arrow on the right-hand side of the Font Color button in the Font 

group. 

 Click the Blue, Accent 1, Darker 25% (5th row, 5th column of colors) 

 

Lesson  6.5  TEXT WRAPPING 

When entering text in cell that is too narrow, the text either flows over to the next cell or does not 

display completely in the cell. To display the entire cell entry, you can adjust the column width or 

make the text wrap within the cell. Wrapping text makes the text flow down within the cell instead 

of flowing to the next cell. 

Steps 

To apply text wrapping to contents within a cell: 

 Select cell A1. 

 Select the HOME tab. 

 Click the Wrap Text button in the Alignment group. 

 

 

Lesson  6.6  CELL ALIGNMENT 

The default alignment of text data, such as labels and column titles is on the left 

side of a cell. Numbers, formulas, and dates, which are referred to as values, are right aligned 

by default.  

Excel’s default alignments are not necessarily the best choice for the data. So, Excel makes it easy 

to improve the layout and appearance of a worksheet by using the cell alignment icons on the 

HOME tab of the ribbon. 
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Lesson  6.7  MERGING CELLS 

In Excel 2013, you can merge two or more adjacent cells into one cell and display the contents of 

one cell in the merged cell. A title is commonly centered over the data in the worksheet. 

 

Steps 

To use the Merge & Center button 

 Select the desired cells  

 Select the Home Tab 

 Click the Merge & Center button in the Alignment group. 
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Lesson  6.8  ADDING BORDERS 

By using predefined border styles, you can quickly add a border around cells or ranges of cells. 

You can create a custom border if the predefined cell borders do not meet your needs. 
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Lesson Seven   FORMULAS 

Lesson  7.1  USING BASIC FORMULAS 

Formulas are used to perform calculations on values entered into the cells of a worksheet. A 

formula is an equation that performs a calculation. Excel can execute many formulas, including 

those that add, subtract, multiply, and divide. One of the most useful features of Excel is called a 

cell reference. Cell reference identifies the location of a cell, and this cell reference can be used in 

formulas.  

Excel uses standard operators for equations, such as a plus sign for addition (+), a minus sign for 

subtraction (-), an asterisk for multiplication (*), and a forward slash for division (/). 

When writing a formulas in Excel, you must begin with an equal sign (=) because the cell contains, 

or is equal to, the formula and its value.  

The mathematical operators that can be used in a formula are listed in the table below 

 

Operator  Action carried  

+ (plus sign)  Addition 

- (minus sign)  Subtraction 

* (asterisk)  Multiplication 

/ (slash)  Division 

( ) (parentheses)  

Controls the order of mathematical operations; 

calculations within parentheses are performed 

first. 

% (percent)  

Converts a number into a percentage; for 

example, when you type 10%, Excel reads the 

value as .10. 

^ (caret)  
Exponentiation; for example, when you type 

2^3, Excel reads the value as 2*2*2. 
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Sample of Basic Excel mathematical formula 

Addition + =5+5 

   

Subtraction  - =5-5 

   

Multiplication  * =5*5 

   

Division  / =5/5 

   

Exponents ^ =5^5 

  

When more than one operator appears in a formula, it is calculated using the standard mathematical 

order of precedence. This order determines which operations are carried out first. The order of 

precedence is as follows: 

 Parentheses 

 Exponentiation 

 Multiplication and division 

 Addition and subtraction. 

For example, the result of 3+4*5 is 23, but the result of (3+4)*5 is 35. 

 

Lesson  7.2  ENTERING FORMULAS 

Formulas are the Bread and butter of worksheet. Without formula, worksheet will be just simple 

tabular representation of data. A formula consists of special code, which is entered into a cell. It 

performs some calculations and returns a result, which is displayed in the cell. Formulas begin 

with an equal sign (=) to tell Excel to perform a calculation and usually contain cell addresses. The 

equal sign prevents Excel from interpreting the formula as text, since all cell addresses begin with 

letters. You enter a formula in the cell where you want the result to appear.  
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When you enter a formula into a cell, you can either type the cell addresses referenced or use the 

mouse to select the cells and allow Excel to enter the cell addresses into the formula automatically. 

As you type or select cell addresses, Excel places a colored border with squares at each corner 

around each referenced cell. 

Lesson  7.3  BASIC FUNCTIONS 

There is a long list of Excel’s built-in formulas that make it easy to perform complex mathematical 

operations. These formulas are organized into categories which you can view. You can use the 

Insert Function button to insert the basic functions. 

 

The basic functions are  

Function  Name  Description  

Sum  SUM  Sum the values  

Average 

 

AVERAGE 

 

Average Values 

Minimum 

 

MIN Smallest value  

Maximum  Max  Largest Value  

Count  COUNT The number of data values 

 

Counta 

 

COUNTA  The number of data values in 

non-blank cells 
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Steps 

To use functions:  

 Select the cell into which you want to enter the formula 

 On the FORMULAS tab in the Functions Library group, click the Insert 

Function button 

 Select SUM from the Select a function list and click the OK button. 

 Select the Collapse Dialog button for the argument you want to edit. 

 Select the range you want to use in the calculation. 

 Release the mouse button 

 Select OK. 

 

Lesson  7.4  USING AUTO COMPLETE 

Although the AutoSum list assists you in creating formulas for the most commonly used functions, 

you may prefer to manually enter a function. The SUM, AVERAGE, MAX, MIN, and COUNT 

functions are entered with the same syntax, including beginning the function with an equal sign 

(=) and then typing the name of the function and an open parenthesis. You then enter the cell range 

by dragging to select the cells or by typing the first and last cells in the range. These functions are 

defined in the following table: 

 

Function 

 

Example 

 

Description 

 

SUM 

 

=SUM(A1:A20) 

 

Returns the average of a range 

of numbers; if a cell in the 

range is empty, it is not used 

in calculating the average; if a 

cell in the range contains the 

number 

zero, it is used in calculating 

the average. 
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MAX 

 

=MAX(A1:A20) 

 

Returns the highest value in a 

range of numbers. 

 

MIN 

 

=MIN(A1:A20) 

 

Returns the lowest value in a 

range of numbers. 

 

COUNT 

 

=COUNT(A1:A20) 

 

Returns the number of cells in 

the range that contain 

numbers. 

 

COUNTA 

 

=COUNTA(A1:A20) 

 

Returns the number of cells in 

the range that contain data 

(e.g. text or numbers). 

 

ROUND 

 

=ROUND(A1,0) 

 

The numbers are rounded to 

the nearest whole number. 

 

 

After you type an = (equal sign) and the beginning letters of a formula, the Formula 

AutoComplete feature displays valid functions, names and text strings that match the letters in a 

dynamic drop-down list. 

 

Lesson  7.5  USING AUTO CALCULATE 

The fastest way to perform a calculation on a range of cells is by using the Auto Calculate feature. 

And the best part is, you don’t even have to type in a formula – it’s automatic! Whenever you 

highlight a range of cells, the sum of that range is displayed in the status bar 

However, you aren’t limited to just the SUM function. You can also calculate the Average, Count, 

Count Nums, Maximum, and Minimum of the range simply by right clicking on the Status Bar 

and choosing the desired function. 
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Step 

To use the Auto Calculate feature: 

 Select the range you want to calculate. 

 Release the mouse button. 

 To enable additional Auto Calculate results, right click anywhere on the Status 

Bar. 

 Select the desired Auto Calculate function(s). 

 Select the Status Bar. 

 

Lesson  7.6 MODIFYING FORMULAS USING RANGE BORDERS 

Steps 

To use range borders to modify a formula: 

 Double-click the cell containing the formula you want to edit. 

 To change the size of a referenced range, point to the square range handle at the 

appropriate corner of the range border. 

 Drag the range border to the desired position. 

 Hit [Enter]. 

 

 

 



31 
 

Lesson  7.8  ERROR CHECKING 

It is possible to implement certain rules to check for errors in formulas, similar to a spelling 

checker. While the rules do not guarantee that your worksheet is error free, they can go a long way 

toward identifying repeated mistakes. 

 

Error Cause  

#NAME? Does not recognize text in formula 

#DIV/0! Formula or function used is divided by zero or empty cell 

#REF! Cell Reference is not valid 

##### Column is not wide enough to display value 

#Value! Wrong type of argument or operand is used 

#N/A Value is not available to a function or formula 

#NUM! Invalid numeric values in a formula or function 

#NULL! Cell references are not separated correctly in a formulas 

 

 

Lesson  7.9  USING THE IF FUNCTION 

Logical functions calculate outcomes based on criteria. If the criteria are true, one action is taken; 

if the criteria are false, a different action is taken. Logical functions can be used in a range of 

situations. For example, you can use a logical function to decide if a student has passed a test. If a 

mark is greater than or equals a specified value, the student passes. If the mark is less than the 

specified amount, the student fails.  

The IF function returns one value if a condition is true and another value if a condition is false. In 

the example above, if the test score is greater than or equal to the pass mark, a true value is returned. 

If the score is less than the pass mark, a false value is returned. You can use the IF function to 

display text as a result of a logical test, but you must enclose the text you want to display in 

quotation marks. 

For example. 

Where the value in cell A1 is 56 

The formula =IF(A1>49,"PASS","FAIL") returns "PASS"  
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Because the formula given state that, if the value in cell A1 is greater than 49 give PASS but if it 

is less than 49 give FAIL.  

 

Lesson  7.10  COPYING FORMULAS 

When you copy cells containing formulas, Excel adjusts the cell references to the row or column 

where the formula is pasted. For example, if the formula  =B5+B6+B7+B8 calculates the total of 

three cells in column B and you copy that formula to the adjacent cell in column C, Excel adjusts 

the formula to =C5+C6+C7+C8 so that the total of the three corresponding cells in column C are 

calculated. 

 

Lesson  7.11  FILLING CELLS 

It is possible to enter data automatically in Excel using the Auto Fill feature. This feature operates 

by using data or patterns in existing cells, allowing you to drag and fill in several cells using the 

fill handle. 

 

 

 

Steps 

To fill a range. 

 Select the cell containing the data you want to copy. 

 Point to the fill handle at the bottom-right corner of the selected cell. 

 Right Click and Drag the fill handle over the range you want to fill. 

 Release the mouse button. 

 Select Fill series  

 

Lesson  7.12  SORTING 

Sorting data is an integral part of data analysis. Sorting data helps you quickly visualize and 

understand your data better, organize and find the data that you want, and ultimately make more 

effective decisions.  
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Tip: when you are creating a list, avoid blank rows and columns in the main body of the list. An 

exception to this is when you might want to insert a blank row before the Total row. Sorting data 

is useful in a variety of contexts. You might want to put a list of names in alphabetical order, 

compile a list of levels of stock from highest to lowest, or order rows by colors or icons. You can 

quickly sort your data by using the A-Z and Z-A Sort buttons on the Ribbon's DATA tab. 

Steps 

To sort a list in ascending or descending order. 

 Select the Data Tab 

 Select any cell in the column you want to sort. 

 Click the Sort A to Z button in the Sort & Filter group on the DATA tab. 

 

 

Lesson  7.13  FINDING DATA 

Excel‘s Find and Replace feature can be a powerful tool. You use Find and Replace to search for, 

and optionally replace text or values in a worksheet. You can narrow the search results by 

specifying formatting to look for as well as other search options, including Match Case. 
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Lesson Eight   CREATING CHARTS 

Lesson 8.1  INSERTING A COLUMN CHART 

You can create basic charts in Excel by selecting a suggested chart type. It is also possible to 

modify the chart, apply predefined styles and layouts, and add formatting to create a professional-

looking chart. Data which has been arranged in columns or rows on a worksheet can be plotted in 

a column chart. A column chart usually displays categories along the horizontal (category) axis 

and values along the vertical (value) axis. 

Steps 

To create a column chart: 

 Select the INSERT tab. 

 Select the cell range containing the data you want to chart 

 Select the Column button in the Charts group. 

 Select the 3-D Clustered Column chart subtype from the gallery. 

Note:  

You can use this same method in inserting a Line chart, Bar chart and Pie chart  

 

Lesson  8.2  ADDING CHART TITLE 

Adding a chart title in Excel can help identify work in a worksheet, as well as adding a finishing 

touch to a chart, especially if used for presenting data in the future 

Steps 

To add a title to a chart: 

 

 Select the chart you wish to insert the Title 

 Select the Add Chart Element button in the Chart Layouts group. 

 Select the Chart Title button from the list displayed 

 Select the Above Chart option. 

 Type the title as necessary. 

 Select the [Enter] key. 
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Lesson  8.3  CHANGING THE CHART BACKGROUND 

Changing the background of a chart can add depth to the chart’s data, and make the colors of a 

chart more defined. 

Steps 

To change the chart background. 

 Select the Design tab on the Ribbon 

 Select the FORMAT tab from the CHART TOOLS contextual tab. 

 Select the Chart Area option in the Current Selection group. 

 Select the Format Selection option from the Current Selection 

group. 

 Select the FILL option from the right pane. 

 Select Gradient fill from the list displayed. 

 

  

  



36 
 

Lesson Nine  PRINTING 

 

Lesson  9.1  PRINT PREVIEW 

 

Preview and printing is carried out in Microsoft Office Backstage view. 

 

Steps 

To Preview the current worksheet before printing: 

 

 Select the FILE tab 

 Select the Print option 

 

Lesson  9.2 PRINTING THE CURRENT WORKSHEET 

Steps 

To print the current worksheet: 

 

Select the FILE tab. 

Select the Print option. 

Select the Printer list. Select the desired printer from the list. 

Select Print. 

 

Lesson  9.3 APPLY AUTOMATIC TITLE ROWS TO ALL PRINTED PAGES 

Applying automatic title rows to all printed pages of a worksheet is useful for long tables that may 

contain a lot of data. Having a title on each page to differentiate the rows will be effective in 

keeping track of what you are viewing. 

Steps 

 Go to the Page Setup group in the PAGE LAYOUT tab.  

 Choose the Print Titles option. 

 In the Rows to repeat at top box, click the box at the right hand side. 

 Select the row you want to repeat at the top of the printed pages. 

 Click OK 
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Lesson  9.4  PRINTING A SELECTED RANGE 

Steps 

To print a selected worksheet range: 

 Select the range you want to print. 

 Release the mouse button. 

 Hold [Ctrl] and select additional ranges, if desired. 

 Release the mouse button. 

 Select the FILE tab. 

 Select the Print option 

 Select Print Selection from the Settings list. 

 Select Print. 

 

 

 

 

 

 

 

 

   

 

 

 


